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2. Click , when the button icon changes to Q‘ﬂ, the filter browsing mode will be activated

(Figure 4-39). In this mode, the software displays only tagged or captured images for further
screening.

& ESView - doctor: YUE - 2021-11-22 - XZVU - Small Bowel - 21062024708 - o X

Fle Tool Display Help

<
Stomach transit time: 00:21:37 __|[Small bowel transit time: 03:42:37_|Colonic transit time: 12:51:46 | Total video time: 16:58:26 Index: 37/79

Figure 4-39: Filter Browsing Mode

4.4.9 Option Setting

1. Inthe main software interface, select “Tool” = “Option” to access the option setting interface
(Figure 4-40).

ANKON Technologies Co., Ltd. AKQWO-YF-018 RevA/1



NaviCam Small Bowel Capsule Endoscopy System User Manual Page |51

& Options >
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Figure 4-40: Option Setting Interface

2. Inthe “Department” area, fill in the department information, which will appear in the case
report.

3. Inthe “Export path” area, choose the paths for exported video files and raw data. If the
“Delete RAW files after exported” option is checked and the data is exported to video file
using the direct export mode, then after export, the related RAW files in the RAW file path
will be automatically deleted to save space.

4. Inthe “Others” area, if the “Display image preview when mouse hovers over the time
progress bar” option is checked, as the mouse moves over the progress bar, the preview of
the image corresponding to the mouse location will be displayed in a floating window if the
mouse stops for about 1 second, as shown in Figure 4-41.
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& ESView - doctor: YUE - 2021-11-22 - XZVU - Small Bowel - 21062024708

Fle Tool Display Help

Stomach transit time: 00:21:37  |Small bowel transit time: 03:42:37 [Colonic transit time: 12:51:46

Figure 4-41: Image Preview

5. Ifthe “Add patient info when save images or mp4 videos” option is checked, the patient
information will be added to the upper left, upper right, and lower left corners of the save

image, as shown in Figure 4-42. Left click to save the current image. Right click to

open the folder where the saved images are located. If the “Open the finding file when
opening the video images” option is checked, then the user can open the last saved finding
file when opening the patient video.

2021-11-22

ANKON

Figure 4-42: Saved Image Showing Patient Information

4.4.10 NaviCam ProScan

NaviCam ProScan feature contains two main functions:
— Images of suspected positive lesions (including four kinds: lymphangiectasia .

Inflammation/erosion/bleeding/ulcer. polyp/bulging or ymphoid follicular hyperplasia
and diverticulum) are automatically marked, and the image position is marked in red on
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the image ribbon.

— The esophagus, stomach, and small intestine are automatically segmented for the
digestive tract image, and different digestive tract segments are marked with different
colors on the image ribbon.

This NaviCam ProScan feature can only be used when the following 3 conditions are met:

1) Check the "Allow NaviCam ProScan (requires restart)" option, and restart the ESView
software to take effect, as shown in Figure 4-43.

&2 Options >

GAESView Dt
GMESView Raw Data Browse

(SIS < S <

Figure 4-43: ProScan Feature Option

2) Use "Export and convert data into video file" or "Convert existing RAW file into video files" to
export data. After exporting, check "Recognize Progress" as 100% and "Recognize Status" as
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"Recognition success" in the Case Management case list; as shown in Figure 4-44.

& Case Management

QBB 0o

Finding Video Report Sefting Edit

- o X

“Inquire

ESView Data

Procedure date Al ~ | Procedure type  Any Narme | test00 |

Referral dept. |

] case e[ |

Export to xls

Capsule SN | | Physician name | |

Physician reader |

| Exam result |

|| Refresh Reset

Name Capsule SN Gender Age  Height Weight Case No,

test001 22011100003 Female 38 170 S0 2022011802 18-01-2022 a1z az

test001 | 22011100003 Male 50 170 50 2022011802 18-01-2022 a12 a2z

Exam date Referral dept. Referral doctor Physician nar

b1z o

bi2 o

me Data export Remark Image Report Recognize Progress

Recognize Status
x] © I 00 Recogn
) © N 0 Recooniion success

e e e | Free space: 757 GB

Figure 4-44: Recognize Progress

3) If suspected positive lesions are found.

1. If the NaviCam ProScan function is not enabled, there will be no ProScan icon displayed
on the main interface of ESView. If the NaviCam ProScan function is enabled but the data has
not been automatically identified and processed by ProScan, the ProScan icon can be
displayed by selecting “File” = "Open Video”. The icon will appear gray, as shown in Figure
4-45. Only after the above three conditions are met, the ProScan icon displayed by opening

the data will turn blue.

& ESView - doctor: YUE - 2021-11-22 - XZYU - Small Bowel - 21062024708

Fle Tool Display Help

 Index: 3870/48764

[Not remarked: Esophagus Stomach Small bowrel Large intestine Last digestive tract | Stomach transit time:  Small bowel transit time: | Colonic transit time:  Total video time: T

Figure 4-45: NaviCam ProScan function is enabled
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2. When the NaviCam ProScan icon is blue, the images of suspected positive lesions are
marked with red on the image color band, and the "First esophagus image", "First stomach
image" and "First small bowel image" images are displayed in the image capture area. Mark

position and segment color on the image ribbon, as shown in Figure 4-46.

& ESView - doctor: YUE - 2021-11-22 - XZYU - Small Bowel - 21062024708 = o X

file Tool Display Help

Figure 4-46: NaviCam ProScan Total Images Mode

3. When the NaviCam ProScan icon is blue, the default is Total Images Mode, click to

switch to NaviCam ProScan Mode, the button color changes to orange, click @ to switch
to Normal Images Mode, the color changes to green, as shown in Figure 4-47 and Figure

4-48, click to switch back to Total Images Mode.
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& ESView - doctor: YUE - 2021-11-22 - XZYU - Small Bowel - 21062024708 - =] X

File Tool Display Help

ot remarked: Large intestine Last digestive tract |Stomach transit time: 00:21:45 | Small bowel transit time: o

Flgure 4-47: NaviCam ProScan Mode

& ESView - d YUE - 2021-11-22 - XZYU - Small Bowel - 21062024708 - 0o x

File Tool 5§ lelp

g ks ket Stomach transit time: 00:21:45_|[Sgal lohl et s e oo trmeest s Ot il |index s4s0/46582 |
Figure 4-48: NaviCam ProScan Normal Images Mode

4.4.11 Add to Atlas

1. Move the mouse over the image, right click the mouse and select “Add to Atlas” in the pop-up
menu (Figure 4-49) to access the add to atlas interface.
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B ESView - doctor: YUE - 2021-11-22 - XZVU - Small Bowel - 21062024708 - o X

File Teol Display Help

rrrrrr

TTotal video time: 165626 Inder: 3910/48764 ]) |

Figure 4-49: Add to Atlas

position: Smallbowel  |lstomach transit time: 00:21:37 _|lSmall bowel transit ime: 03:42:37_[[Colonic transit time: 12:51:46

2. Inthe add to atlas interface, select an atlas type in the list on the left and fill in the name in
the text box on the right, as shown in Figure 4-50. Click “OK” to confirm.
é¥ Add to atlas X

v Normal Anatomy
Esophagus
Cardia
Body
Fundus
Antrum
Angulus
Pylorus

Duodenum

Small Bowel :
¥ Gl Tract Lesions

Esophageal Diseases E(P

Gastric Diseases

Gastric Polyps

Gastric Telangiectasia

Gastric Lymphoma

Gastric Cancer

Erosive Gastritis

Gastric Ulcers

Hyperplastic Antral Gastritis
Protrusive lesions or polyps in...

Gastric mucosal scar

Gastric mucosal vascular dysp... ||

Protrusive lesions in Gastric s...

Gastric Xanthoma v Cancel

Figure 4-50: Add to Atlas Interface

3. Inthe main software interface, select “Tool” = “Capsule endoscopy atlas” to access the
capsule endoscopy atlas interface. Select a landmark of the digestive tract, for instance
“Esophagus”, in the left column, the images added in steps 1-2 will be displayed, as shown in
Figure 4-51.
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& Capsule Endoscopy Atlas

v Normal Anatomy A
Esophagus.
Cardia
Body
Fundus
Antrum
Angulus
Pylorus
Ducdenum
Small Bowel
~ Gl Tract Lesions
Esophageal Diseases

Gastric Diseases

Gastric Polyps
—

Figure 4-51: Capsule Endoscopy Atlas Interface

4.5 Report Generation

1. Inthe main software interface, click to access the report generation interface (Figure
4-52).

Figure 4-52: Report Generation Interface

2. Move the mouse over the captured image area and double click to select images. The
selected images will then be added to the report image area. Double click on images in
report image area to remove them. The “Select all” or “Clear” buttons can be used to select
all captured images for report or remove all images from report (Figure 4-53).
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Figure 4-53: Select Images for Report

3. Move the mouse over the timestamp of an image and double click the left mouse button to
edit image comment in the text box below the image (Figure 4-54).

]
Seandard templste  Frequertly used commant

Upper Part of Esophagus
Lower Part of Esophagus

Zine
Cardia
Fundus.

Patiect i Fermale, 39 years oid, height s 155 em
Inications: Crhar

nnnnnnn

Figure 4-54: Edit Report Image Comment

4. Inthe captured image area and report image area, right clicking the mouse button will bring
out the edit menu. Click “edit” to add annotation and comments.

5. The text boxes in the report generation interface can be used to input information that will
be displayed in the case report. Similar to the add comment interface, the user can manually
input or use useful expressions to add information.

6. If Microsoft Word is installed, click “Preview report” button to open Microsoft Word and
access the report preview, as shown in Figure 4-55.
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@ anHOr] Capsule Endoscopy Systems Report ey

Name: XZYU Gender: Female Date of Birth: 22-11-1982

Case No.: 02018XZYU Capsule SN: 21062024708 Examining Date: 22-11-2021

Examining Physician: YUE

Reason for referral:
Indications: Other

Cleansingness Level: ; Esophagus transit time: 00:00:03, stomach transit time: 00:21:37,
small bowel transit time: 03:42:37.

Endoscopic Findings:

The total duration of capsule endoscopy 16hr58mins26sec, the capsule enters into the esophagus at
2mins23sec, into the stomach at 2mins26sec. into the small bowel at Ohr24mins3sec, and into the
large intestine at 4hrémins40sec. At the end of the examination, the capsule is located at **.

Esophagus: Smooth mucosa with excellent contraction force.

Cardia: Regular opening and closing

Fundus: Clear mucin pool, Smooth mucosa, no varicose veins,

Gastric Body: Smooth mucosa, no significant congestive edema, no visible ulcerative mass.

Angulus Incisure: Curved appearance and smooth.

Gastric Antrum: Excellent motility, Smooth mucosa, no visible and significant erosion, uicer or mass
over the mucosa.

Pylorus: Round shape, with reguiar opening and closing

Duodenum: Normal bulbar shape, no abnormal findings over the mucosa, and no erosion, ulcer or
mass is found over the rest of the mucosa.

Jejunum and lleum: Unobstructed intestine, integrated mucosa, no abnormal findings over the
mucosa, no erosion, ulcer or mass.

Examination Result:
Example

Suggestion:
Maintain mental health,ensure the quality of sleep.keep warm and avoid colds and flu

signature: Report Date: _ 08-03-2022
TEL: ADDR: 1/1

Figure 4-55: Report Preview

7. Inthe report generation interface, click "Save report", choose a directory and click “Save” to
save the case report (Figure 4-56). The software saves reports in *.pdf format by default. The
user may also choose to save reports in *.doc format (Figure 4-57). After saving, a dialog box
will appear to indicate saving success (Figure 4-58). Click “OK” to complete report saving or
click “Open” to open the saved report.

¥ Save report
o
S [ | « ESViewData » LXF(2019111501) 19011002747 20131115 » -\&,\ Sex
Organize v New falder
e 4 Mame . Datemodified Ty -
B Desktop data 5 File folder
& Downloads LXF(2019111501) 19011002747 20191115 ... 12/4/2019 516 PM  File folder
‘| Recent Places LXF(2019111501)_19011002747_20191115_...  12/5/201910:34 AM  File folder
i Libraries
5| Documents
& Music
=/ Pictures
B videos
78 Computer
&L SYSTEM (C)
= DATA (D)
IR X (7010111501) 10011002747 20151113] =
Save as type: [PDF Document(* pd) -
“ Hide Folders see | [ Concel |

Figure 4-56: Save Report in .pdf Format
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-.ﬁsava'v:pod

Organize v Newfolder
7 Favorites = Name

B Deskiop i data

4 Libraries
[Z] Documents
& Music

=] Pictures

B videos

1% Cornputer
&L SYSTEM (C)
a DATA (D)

File name:  LXF{2019111501) 10011002747 20101115

& Downloads LXF(2019111501)_19011002747_20191115 _...
% Recent Places LXF(2019111501) 19011002747 20191115 _...

C\J [ 1 < ESView Data » LXF(2019111501] 19011002747_20191115 » ~ [ 42 ][ Search LFcz0:

Date modified Type
File folder

File folder
12/5/201910:34 AM  File folder

Save as type: | Microsaft Word 2007-2016 document(*.doc)

]

4 Hide Folders

Cancel

Figure 4-57: Save Report in .doc Format

+¥ Save Successfully ﬁ

Figure 4-58: Saving Success Dialog Box

8. Inthe main software interface, select “File”

information. Subsequently, the user can select “File”

video with all the findings again.

“Saving finding” to access the save finding
interface (Figure 4-59). The finding file saves image markings, comments, and other textual

“Open finding” in the menu to load

% Saving finding

Organize Newfalder

% Name

»{ Favorites

B Deskiop | data

4 Libraries
%] Documents
& Music
=/ Pictures
Videos

8 Computer
&L SYSTEM (C)
= DATA (D)

Ou | « ESView Data » LXF(2019111501) 19011002747 20191115 » -\&,H Search

& Downloads LXF(2019111501) 19011002747 20191115 ... 12/4/
":‘ Recent Places LXF(2019111501)_19011002747_20191115_... 12/5/201810:34 AM  File folder
| LXF(2019111501) 19011002747 _20191115.... 12/5/2019 10:36 AM  ACIL File

Date modified Type

12/4/2019 215 PM File folder
9516 PM File folder

16 KB

EOET S KF(2019111501) 19011002747 20191115

Save as type: [ ANKON Finding Files(".zcil)

™

“ Hide Folders

Figure 4-59: Save Finding Interface

9. Inthe report generation interface, click the “Report setting” button to access the report
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setting interface. The user can set image zoom scale in the report, image quantity, font size
of the comments, whether to print image background, and whether to add patient
information in the image. Click “OK” to save report setting changes. Click “Cancel” to exit the
interface without saving changes.

4.6 Case Management

1. Inthe main software interface, select “Tool” = “Case management” to access the case
management interface (Figure 4-60). The software will automatically add the data export
path to the case data storage path.

Figure 4-60: Case Management Interface

2. Click @ to access the add case data storage path interface (Figure 4-61). Click “Add”,

“Delete”, or “Rename” button to add, delete, or rename the case data storage path. Click “Save” to
save changes in settings or click “Cancel” to cancel changes.

@ Settings . - 9§ = [

Case path management | View setting

Path
D\ESView Data ESView Data

Figure 4-61: Add Case Data Storage Path Interface
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3. The software automatically searches two levels of directory under the case data storage path
and displays the patient information found in the case list. In the add case data storage path
interface (Figure 4-61) click “View setting” to access the view setting interface (Figure 4-62).
Drag the mouse or click the “<<” or “>>" buttons to select the data fields to be displayed. The
date fields in the “Available Column” box will not be shown in the case management interface,
while the data fields in the “Used Column” box will be displayed.

¥ Settings x

Change file path ~ View setting

Reservation Code Name
InPatient No. Capsule SN
Stomach transit time

Small bowel transit time

Colonic transit ime

Contact No.

QutPatient No.

Chief complaint Exam date
Medical History Referral dept.
Medication Referral doctor
Sequence ID Physician name
Progress Data export
Status Remark Image

Procedure type Report

Figure 4-62: View Setting Interface

4. Inthe case management interface (shown in Figure 4-60), select a case and click to

open the case video and load the finding file. Click to open the case video, click to

open the recently saved report, click to access the patient information editing interface

(Figure 4-63), where you can change patient data. Alternatively, in the main software
interface, open a video file and select “File”> “Edit patient info” to access the patient
information editing interface.
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& Checkin X

Name

170 cm B 50.0 kg 2
Case No. Capsule SN

2022011802 22011100003
]

Figure 4-63: Patient Information Editing Interface

5. Using the tools from the “Inquire” area, the user can filter cases by procedure date,
procedure type, capsule SN, patient name, physician name, and exam result. Click the
“Refresh” button to update cases. Click the “Reset” button to reset filters and update cases.

4.7 Capsule Endoscopy Atlas

1. In the main software interface with an opened video, double click one image in the
thumbnail area and select “Tool” > “Capsule endoscopy atlas” to access the capsule
endoscope atlas interface (Figure 4-64).
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@& Capsule Endoscopy Atlas

v Normal Anatomy

Esophagus

Cardia

Body

Fundus

Antrum

Angulus

Pylorus

Duodenum

Small Bowel
~ Gl Tract Lesions
Esophageal Diseases
Gastric Diseases
Gastric Polyps

Default size

Figure 4-64: Capsule Endoscopy Atlas Interface

2. Click on the normal anatomy images or typical GI tract lesions in stomach, duodenum, and
small intestine. Select the stomach area or lesion type to be compared and view the
corresponding normal anatomy images or lesion images, as shown in Figure 4-65.

& Capsule Endoscopy Atlas

~ Normal Anatomy
Esophagus
Cardia
Body
Fundus
Antrum
Angulus
Pylorus
Ducdenum
Small Bowel
¥ Gl Tract Lesions.
Esophageal Diseases
Gastric Diseases

Gastric Polyps

Default size

Figure 4-65: Normal Anatomy Images of Small Bowel

3. On the atlas image to be compared, right click and select “Compare” in the pop-up menu to
open the image comparison interface and compare the selected exam image with the atlas
image, as shown in Figures 4-66 and 4-67. The image scaling factor can be changed by

dragging the slider or scrolling the mouse.
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Compare

Confirm

Delete

Figure 4-66: Comparison Between Exam Image and AtlasImage

Figure 4-67: Image Comparison Interface

4. After comparison, if the location or lesion of the exam image is confirmed, click the green
checkmark in the upper right corner of the image comparison interface to close it. The
software will automatically add the name of the atlas image as a comment to the exam
image (Figures 4-68 and 4-69).
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& Capsule Endoscopy Atlas - o x

~ Normal Anatomy

Lscjunum.

Figure 4-69: Name of Atlas Image Added as a Comment to the Exam Image
4.8 Software Help

1. In the main software interface, select “Help” = "About” to access the software information
interface (Figure 4-70). The interface shows the full name, version number, and the
manufacturer of the software.
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ESView 2.2

AMKON Technologies Ca., Ltd.

Figure 4-70: Software Information Interface

In the main software interface, select “Help” = “Instruction” in the menu to access the user
manual.

Software Configuration Backup/Restore

The software supports configuration file backup and restore. The user can automatically or
manually backup the configuration files of the software. The default backup path is
D:\ankonConfigBackup\yyyymmdd_hhmmss. The user can manually restore the backup
configuration files.

During initialization, the software will check if there are backup configuration files for the
day. If not, it will automatically backup one.

Select “Help” = “Backup configuration files” in the menu to manually backup the
configuration files once. If the backup is successful, a dialog box confirming successful
backup will appear (Figures 4-71 and 4-72).
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&¥ ESView
File Tool Display | Help
Backup Configuration files

Restore Configuration files

Register Product
Instructions

About

Figure 4-71: Backup Configuration File

% Prompt pe

Backup configuration files successfully!

Figure 4-72: Dialog Box to Confirm Successful Backup of the Configuration Files

4. Select “Help” > "Restore configuration files” to open the restore configuration file selection
interface, select the folder where the configuration files to be restored are located and click
“Select Folder”, then click “Confirm” in the pop-up dialog box to confirm configuration file
restore. A dialog box will pop up to confirm the successful restore, as shown in Figures 4-73
to 4-76.

& ESView
File Tool Display | Help

Backup Configuration files

Restore Configuration files

Register Product
Instructions

About

Figure 4-73: Restore Configuration File Manually
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— | » Computer » DATA(D:) » ankonConfigBackup » -|£,_|'| Search ankenConfigBockup P |
Organize New folder = @
R Name : Date modified Type Size

B Desktop | 20191203 114532 12/3/201911:45 AM  File folder
15 Downloads 1 20191204 092858 12/4/20199:30 AM  Fille folder
" Recent Places 1 20181205 094500 12/5/20199:45AM  File folder
| 20191205_104508 12/5/20191045 AM  File folder
4 Libraries
[=! Documents
& Music
=] Pictures
¥ videos

1= Computer
&L SYSTEM (C)
a DATA (D)

€ Network

Folder: |

Figure 4-74: Restore Configuration File Selection Interface

¥ Restore configuration file x

Figure 4-75: Dialog Box to Confirm Configuration File Restore

¥ Prompt >
& p

A

Figure 4-76: Dialog Box to Confirm Successful Restore

4.10 Software Exit

1. Inthe main software interface, select “File” = “Exit” in the menu or click the button on

the upper right corner, then on the pop-up dialog box (Figure 4-77) click “Yes” to exit or “No”
to cancel.
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Figure 4-77: Exit Dialog Box

2. [Ifacasereportis changed, the user will be presented with the save finding dialog box
(Figure 4-78) upon exit, where the user can click “Yes” to save findings, “No” to exit without
saving findings, or “Cancel” to cancel exit.

@& Save finding it

Figure 4-78: Save Finding Dialog Box
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CHAPTER 5: USING THE CAPSULE

The capsule is packed in a sealed package. You can directly take the capsule out and activate it as
shown in the following figures. The protective cover is used as a fixture and protects the capsule,
facilitating its storage and handling before operation.

-~
. { 5
__f' / Er' ."r
/ J./” i / /
< R __,: P
f,r.'.b-_ A '-.1.- - 7
A E-. .,‘%.
/ & /

Figure 5-1: Schematic Diagram of Capsule Activation for Use

Tear off the paper cover of the package box.

Remove the capsule with fixture from the cup and remove the upper part.
Remove the capsule.

Activate the capsule with light irradiated from the Locator.

B W N e

WARNING
A ® The capsule must be removed and activated before ingestion and
operation.

® The capsule should only be stored in the original package before
ingestion.

® The capsule is provided sterile. Do not use a capsule if package is
damaged.

® Disposal of capsules should be done according to local regulation
for disposal of electronic products.

ANKON Technologies Co., Ltd. AKQWO-YF-018 RevA/1



NaviCam Small Bowel Capsule Endoscopy System User Manual Page |73

CHAPTER 6: USING THE DATA RECORDER

6.1 Data Recorder(AKR-1)
6.1.1 Installation and Use

The Data Recorder is equipped with 14 sensor arrays, as presented in Figure 6-1.

Figure 6-1: Data Recorder (AKR-1)
When in use, the Data Recorder and sensor arrays are embedded into the corresponding
examination vest as shown in Figure 6-2. As tested, the working temperature of the data
recorder can reach 42°C tested under 40°C ambient temperature. Since the data recorder does
not contact patient skin directly, the temperature will not cause burn or other hazard to patients
and operators, and the contact duration can be longer than 10 minutes.

/{ \

Figure 6-2: AKR-1 Data Recorder Vest

WARNING
A ® Data Recorder AKR-1 can only be used with Capsule AKES-11SW.

6.1.2 Operation Instructions

Related marks and position of power switch, USB interface, LED, keys on the Data Recorder are
shown in Figure 6-3.

ANKON Technologies Co., Ltd. AKQWO-YF-018 RevA/1



NaviCam Small Bowel Capsule Endoscopy System User Manual Page |74

Figure 6-3 AKR-1 Data Recorder Operation Manual
@: Alarm indicator, yellow; @: Power switch;
(2): Run indicator, green; (8): USB interface to connect

(3)@)(5): Battery capacity indicators; (9): Charging port.
@: Charge indicator, white;

Hold down the power switch without releasing until all the five LEDs (marked as

(M@ B)@)(5) in Figure 6-3) are lit up to power on the Data Recorder normally. Click the related
button in the ESView to power the Data Recorder off. If the Data Recorder is not connected to the
computer via USB, and therefore no capsule information is detected for a consecutive 15 minutes,
it will automatically power off to save energy. If the yellow LED alarm indicator (marked as (1) in
Figure 6-3 with word “alarm” under it) is always on, it indicates that no capsule is detected. If
on/off continues flashing, it indicates that the capsule is present, however the upper-level
software has not yet issued a command to let the capsule capture images. The green LED run
indicator (marked as (2) in Figure 6-3 with word “run” under it) will be lit up once it receives the
image information from the capsule and off again quickly; it will light up again once it receives
the next image information and then off again. The received image information captured by the
capsule will also be marked accordingly.

The green LED battery capacity indicators (marked as 3)(4)(5) in Figure 6-3, with battery
capacity icon under it, three lattices, two lattices and one lattice specifically) indicate

current battery capacity. It is 90% when (3)(4)(5)LEDs are all lit up, more than 70% when

(4)(5) LEDs are lit up, and 40% when (5) LED is lit up. If only (5) LED is on/off flashing, the
remaining battery capacity is very limited. If the Data Recorder is powered on and being charged,
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these three LEDs will be on and off flashing in a cycle manner. If the white LED charge indicator
(marked as in (6) in Figure 6-3) keeps lighting up, it indicates that it is under charging (it will be
lit up once it is charged regardless of the status of the Data Recorder power). The white LED will
automatically turn off when fully charged.

WARNING
& ® The Data Recorder should be charged only with provided charger.

® Charging can only be performed by the physician/operator.
Patients shall not have access to the adaptor.

6.2 Data Recorder (AKRI-1)

6.2.1Installation and Usage

The (AKRI-1) Data Recorder is composed of Host, Belt-examining cloth and Charging Base, as
shown in Figures 6- 4, 6- 5, and 6- 6 respectively.

Figure 6-4: AKRI-1 Data Recorder Host Figure 6- 5: AKRI-1 Belt-Examining Cloth

= -

Figure 6- 6: AKRI-1 Charging Base

WARNING
& ® Data Recorder AKRI-1 can only be used with Capsule AKES-11SI.

The port in the small pocket of the Belt-Examining Cloth is inserted into the right port of the
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AKRI-1 Data Recorder and then put in the pocket of the Host as shown in Figure 6-7.

)

Figure 6- 7 AKRI-1Belt-Examining Cloth Dressing View

|
i

6.2.2 Operation Description

Through the display of the indicators, interactive operation of the buttons, interface on the Host
to realize AKRI-1 Data Recorder function , including the following:

The LED indicator light, On/Off button, screen display button, USB port, belt port, screen on the
AKRI-1 Data Recorder, and the power-on indicator light, data port, power port on the base.

All of the equipment corresponding identifications and positions are as shown in Figure 6- 8.

(1) Charging Indicator Light

(2) Status Indicator Light

(3) Telecommunication Indicator Light
(4) Power-on Button

(5) Screen Control Button

(6) Display Screen

(7) USB port

(8) Power-on Indicator Light on Base

(9) Data port on Base

Figure 6- 8: Operation Panel of AKRI-1 Data (10) Power port on Base

Recorder

6.2.2.1 Description of Indicator Light

® Press and hold the Power-on button for 3 seconds to boot the AKRI-1 Data Recorder. At this
time, it will display the current state on the Display Screen.
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To power off the AKRI-1 Data Recorder, click the Turn On/Off button in ESView Software
Interface.

If the AKRI-1 Data Recorder cannot detect the information of the capsule for 30 minutes and
cannot connect to the software of Rtdisplay via USB port, it would be automatically power
off to save power.

If the telecommunication indicator light flashes green, it means the capsule’s data are
adequately received.

If the telecommunication indicator light flashes yellow, it means some abnormalities
occurred, but the capsule’s data has been received.

If the telecommunication indicator light does not flash, it means no capsule’s data have been
received.

The Status Indicator Light is should be green. It will turn yellow in the following situations:
(1) Low Battery; (2) Belt not Connected; (3) Other Equipment Exception.

The Charging Indicator Light remains on when power is on and turns off if power is
disconnected. If the Data Recorder is not full charged, the Charging Indicator Light will flash
yellow, if it is fully charged, the Charging Indicator Light will flash green.

Press the Screen Display button to light the screen for 30s. If it is pressed again during the
display, it will count the time again to display for 30s. The information displayed on the
screen is as follows:

Row 1: (1) Telecommunication Status Icon. (2) Battery Icon: Battery charge level.
Row 2: (1) Wireless Channel. (2) The Pattern State of Small Intestine.

Row 3: Check-in state/Time of Examination. It will display “No Entry” if not entered.
Otherwise, it will display the time of examination.

Row 4: Error Information. If there have no error information, no display will appear.

The base can charge and transmit data. The Power-on Indicator Light will flash green when
the power port of the base is powered-on. It can transmit data when the base is connected to
the computer via data port.

WARNING
A ® The Data Recorder should be charged only with provided charger.
® Charging can only be performed by the physician/operator.
Patients shall not have access to the adaptor.
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CHAPTER 7: USING THE LOCATOR

7.1 Operation Panel

Figure 7-1 shows functional keys and indicators of the Locator.

Figure 7-1: Keys and Indicators of Locator

(D : Scanning indicator, Yellow; (5): Power Switch;
(2): Working indicator, Green; (6): Charging port;
(3): Infrared light source to activate capsule;  (7): Power switch indicator, white;
(4): Keys; (8): Label plate.
7.2 Use

7.2.1 Turn-on the Capsule

Before starting the Capsule, press the “Power Switch” to activate the Locator. Once the Locator is
on, the working indicator will flash. Place the Capsule front case opposite to the start infrared
light source of the Capsule. Press and hold the “INIT Button” to align the open position of the
Capsule. The Capsule LED will start blinking after the Capsule is opened normally. The Capsule is
activated as shown in Figure 7-2.
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Figure 7-2: Schematic Diagram of turning-on the Capsule

7.2.2 Locate the Capsule

To detect the location of the capsule in a patient using the Locator, perform the following steps:

1. Turn on: Hold the Locator upright, start the Locator by pressing “Power Switch” in the open
space without metal objects nearby. Once the Locator has started, the working indicator will
flash at a frequency of once per second, and the scanning indicator will be off.

2. Locating: Use the Locator to move gently in the detection area. Once the Locator is near the
capsule, the scanning indicator will light up. When the scanning indicator stays on, it
indicates that the capsule is right below the scanning indicator.

7.2.3 Turn-off the Locator

Press and hold the “Power Switch” for more than 5 seconds and the Locator will shut down. All the
indicators will be off after the shutdown. The Locator will automatically shut down after 10
minutes without any operation.

7.2.4 Charge the Locator

The Locator uses a battery to supply power. When the battery voltage is low, the flashing
frequency of the working indicator will get lower. When the flashing changes to one time per three
seconds, the Locator needs to charge through the power port. During the charging process, the
charging indicator is always on, and is automatically turned off after being fully charged.

WARNING
A ® The Locator can only be charged using a charger that comes with
the unit.

® Charging can only be performed by the physician/operator.
Patients shall not have access to the adaptor.
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CHAPTER 8: TROUBLESHOOTING
8.1 ESView Warnings
Warning Message Cause Action
if\fi(l;;?ais)ipatient Recording fails Add patient information again
Ezgler;lffﬁ f?)(i(rjrigggr?f Record added Click “Confirm” to exit the dialog box
Save change of patient Record changed Click “Confirm” to exit the dialog box

information

Cancel change of patient
information

Confirm cancel

Click “Confirm” to confirm cancel,
or click “Cancel” to undo it

Delete patient information

Confirm deletion

Click “Confirm” to confirm
deletion, or click “Cancel” to
undo it

Add case completed

Record added

Click “Confirm” to exit the dialog box

Delete case information

Confirm deletion

Click “Confirm” to confirm deletion,
or click “Cancel” to undo it

Connection error

Cannot connect to the data
recorder, need to check if
USB is connected properly

Click “Confirm” and reconnect the
data recorder to USB

Data export warning

Data export is not
completed

Click “Yes” to stop data export or “No”
to continue export

Exit video view

Exit video view

Click “Yes” to exit the image browser,
click “No” or “Cancel” to undo it

Confirm exit

Confirm exit

Click “Confirm” to exit the software or
“Cancel” to undoit

Print error

Printer error

Check printer power and printer
settings

8.2 Capsule

Problem

Cause

Action

When activating capsule,
LED light does not lit up

Battery has no power or

Replace the capsule

Capsule is notactivated

Activate the capsule again

Equipment failure

Contact technical
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Problem

Cause

Action

Real-time image is not
transmitted to computer

Transmission problems with

See below actions

Capsule is notactivated

Activate the capsule

8.3 Data Recorder

Exception

Possible Cause

Action

Turn the power switch on,
and LED or screen are not lit

up

Low battery

Charge the system for 8 hours

Device malfunction

Contact a technical support
staff

An image is not transmitted
to your computer in

The capsule is not activated

Use Locator to activate the
capsule

Signal transceiver of the

Contact a technical support

real-time recorder is invalid staff
8.4 Locator
Problem Possible Cause Action
The battery is dead Charge the system again for 8

Turn the power switch on,
and LED not lit up

hours

Device malfunction

Contact technical support
staff

Cannot activate the capsule

Capsule malfunction

Contact technical support
staff

Device malfunction

Contact technical support

staff

WARNING
A ® If problem cannot be addressed with the above actions, please
contact ANKON Technologies Customer Support.
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CHAPTER 9: MAINTENANCE

9.1 C(leaning the Data Recorder Vest/Belt-Examination Cloth

After each procedure, the examination vest/belt should be sprayed with 70% IPA and then wiped
with a clean, dry cloth and air dried for at least 15 minutes. The outer layer of fabric can be
washed in water. For the vest, the inside layer that contains the antenna and cables is not
washable, it is not in direct contact with the human body and does not require cleaning.

The Data Recorder vest/belt should be cleaned as follows:

1. Take the Data Recorder out of the vest/belt.

2. Remove the outer layer of fabric and immerse it in warm water with neutral soap for 20
minutes.

3. Gently rub and then dry it.

CAUTION
A ® Do not dry clean or iron the vest.

9.2 C(leaning the Data Recorder and Locator

The Data Recorder and Locator should be manually cleaned after every use by wiping the
equipment surface gently with a cotton ball lightly dipped in 70% isopropyl alcohol and let it dry
for 15 minutes.

Note:

As the equipment is equipped with batteries inside, please use a cotton ball dipped with 70%
isopropyl alcohol and then squeeze excessive alcohol from the cotton ball before using it for
wiping to avoid alcohol flowing into the equipment through the seams when wiping the edges of
the equipment.
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CHAPTER 10: TECHNICAL SPECIFICATIONS

10.1 Data Recorder (Model AKR-1/AKRI-1)

Operating performance:
Recording time: 8 hours (2fps)
Storage capacity: >4 GB
Battery type: Lithium battery,3.6-4.2 VDC,22500 mAh

Environmental operating conditions
a temperature range to+5 Cto+40 C

a relative humidity range of 15% to 90%, non-condensing but no requiring a water vapour
partial presssure greater than 50 hPa and

An atmospheric pressuer range of 700 hPa to 1060 hPa

Environmental conditions of transport and storage

Temperature Limit: -25 ‘C~70 C
Humidity Limit: 0% ~90%
Pressure Limit: 700 hPa~1060 hPa

Safety type: Built-in power supply type BF continuous
running equipment

Degrees of protection provided by enclosures: P22

Shelf Life of AKR-1/AKRI-1: 5 years

RF Performance

2.4GHz AKR-1

Frequency: 2400~2483.5 MHz
Bandwidth: <3 MHz
Modulation: GFSK

Emission Power: <10 mW(e.i.r.p)

915MHz AKRI-1
Frequency Range: 902MHz-928MHz
Bandwidth: <4 MHz
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Modulation Technique: 8-FSK
Transmit power: <10mW(e.i.r.p.)
Adaptor:
UE15WCP1-052200SPA for Model AKR-1
Input: 100-240 V a.c,50/60 Hz, 500 mA
Output: 52V=2Ad.c
Protection class: class II, continuous duty

UE10WCP1-050200SPA for Model AKRI-1

Input: 100-240V a.c, 50/60 Hz, 500 mA
Output: 50V=2Ad.c
Protection class: class II, continuous duty

Note: The data recorder incorporates a built-in RF module, while the module is completely shut
down by software during operation.

FCCID:
Data Recorder (AKR-1) FCCID: 2A6BYAKR-1
Data Recorder (AKRI-1) FCCID: 2A6BYAKRI-1

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:

(1) this device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.

CAUTION
A ® The user is cautioned that changes or modifications not expressly
approved by the party responsible for compliance could void the
user's authority to operate the equipment.

WARNING
A ® The user shall avoid using RFID technology near the device while it
is operating.
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10.2 Capsule(Model AKES-11SW/AKES-11SI)

Physical performance:
Length:
Diameter:
Weight:

Material:

Optical performance:

[Nlumination:

LED flash frequency:

Camera:

FOV:

FOV(entrance pupil):
FOV(distal window):

DOF:

Resolving power:

Image performance:
Frame rate:

Image resolution:

Magnetic field performance:

Surface magnetic field strength:

27 +1.0 mm
11.8 £ 0.5mm
45+05¢g

Biocompatible materials

LED
0.5~6 Hz adjustable

1 piece

120°+15%
160+10%
0 mm~30 mm

26 Ip/mm

0.5~6 fps adjustable
480*480 adjustable

<2000 Gs

Capsule's non-optic bottom magnetic induction intensity: 96 Gs~360 Gs

Operating performance:
Operating time:
Battery type:

Rated voltage:

Safety type:

=8 hours

Silver oxide cell235 mAh

3vDC

Built-in  power supply type
continuous running equipment

ANKON Technologies Co., Ltd.

AKQWO-YF-018 RevA/1



NaviCam Small Bowel Capsule Endoscopy System User Manual Page |86

Chemical safety: Resistance to dissolve when pH ranges from 2-8

Environmental operating conditions
a temperature range to +5 Cto+40 C

a relative humidity range of 15% to 90%, non-condensing but no requiring a water vapour
partial presssure greater than 50 hPa and

An atmospheric pressuer range of 700 hPa to 1060 hPa

Environmental conditions of transport and storage

Temperature Limit: -25 C~70 C
Humidity Limit: 0% ~90%
Pressure Limit: 700 hPa~1060 hPa

Degrees of waterproof: [PX8

RF Performance
2.4GHz AKES-11SW

Frequency: 2400~2483.5MHz
Bandwidth: <3MHz
Modulation: GFSK

Emission Power: <10mW(e.i.r.p)

915MHz AKES-11SI

Frequency Range: 902MHz-928MHz

Bandwidth: <4MHz

Modulation Technique: 8-FSK

Transmit power: <10mW(e.i.r.p.)
FCCID:

Capsule(AKES-11SW) FCCID: 2A6BYAKES-11SW

Capsule(AKES-11SI') FCCID: 2A6BYAKES-11SI

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:

(1) this device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.
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CAUTION
A ® The user is cautioned that changes or modifications not expressly
approved by the party responsible for compliance could void the
user's authority to operate the equipment.

WARNING
A ® The user shall avoid using RFID technology near the device while it
is operating.

10.3 Locator (Model AKS-1)

Locating performance:

Probing distance: <150 mm

Operating performance:

Battery type: Lithium battery, 3.6-4.2 V DC, ,22500mAh

Safety type: Built-in  power supply type BF
continuous running equipment

Grade of waterproof: IPX 0

Environmental operating conditions
a temperature range to+5 Cto+40 C

a relative humidity range of 15% to 90%, non-condensing but no requiring a water vapour
partial presssure greater than 50 hPa and

An atmospheric pressuer range of 700 hPa to 1060 hPa

Environmental conditions of transport and storage
Temperature Limit: -25°C~70°C

Humidity Limit: 0% ~90%

Pressure Limit: 700 hPa~1060 hPa

Adaptor:

UE15WCP1-052200SPA for Model AKS-1

Input: 100-240V a.c, 50/60 Hz, 500 mA
Output: 52V=2Ad.c
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Protection class:

10.4 ESView Software

class II, continuous duty

ESView software runs on the PC.

CPU: Intel Core i3 2.0GHz or later
GPU:rtx4000 or later

Monitor: Resolution 1920*1080 or higher

HDD: 250GB or above
Memory: 8GB or above
USB Port: 2 or more

Operating System: Windows 7 or above

10.5 Guidance and Manufacturer's Declarations

NaviCam Small Bowel Capsule Endoscopy System complies with the requirements of IEC
60601-1-2:2014, EN 60601 1-2:2015.

10.5.1 Data Recorder

Guidance and manufacturer’s declaration - electronicemissions

The Data Recorder is intended for use in the electromagnetic environment specified below.

The user of the Data Recorder should assure that it is used in such anenvironment.

Emissions test Compliance Electromagnetic
environment - guidance
Radiated emissions The Data Recorder uses RF
CISPR 11 Group 1 energy only for its internal
function. Therefore, its RF
emissions are very low and are
Conducted emissions not likely to cause any
CISPR 11 Class A interference in nearby electronic
equipment.
Harmonic Emissions The harmonic current test and The
[EC 61000-3-2 N/A voltage fluctuation and flick test are
not necessary because the Data
Voltage fluctuations and Recorder isn't intended to be
flicker emissions N/A connected to the PUBLIC MAINS
IEC 61000-3-3 NETWORK.
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Guidance and manufacturer’s declaration - electromagneticimmunity

The Data Recorder is intended for use in the electromagnetic environment specifiedbelow.

The user of the Data Recorder should assure that it is used in such anenvironment.

IEC 61000-4-2

contact discharge
+2~15 kV air discharge

+8 kV Horizontal

Immunity test IEC 60601 testlevel Compliance level Electromagnetic

ment - guidance
Electrostatic +8 kV +8 kV contact discharge Floors should be wood,
discharge +2~15 KV air discharge concrete or ceramic tile. If

floors are covered with

and voltage
variations on
power
supply input
Lines
IEC61000-4-11

At 0°,45°,90°,135°,
180°,225°,270°,315°

0% UT; 1 cycle and 70%
UT; 25/30 cycles

Single phase: at 0°

At 0°,45°,90°,135°,
180°, 225°,270°,315°
0% UT; 1 cycle and 70%
UT; 25/30 cycles

Single phase: at 0°

+8 kV Horizontal Coupling synthetic material, the
Coupling +8 kV Vertical Coupling | relative humidity should be
+8 kV Vertical Coupling at least 30%.
Electrical fast +2 kV for power supply | 2 kV for power supply | Mains power quality should
transient/burst | Lines be that of a typical
IEC +1 kV for input/output commercial or hospital
61000-4-4 Lines environment.
Surge IEC/EN +0.5kV, 1 kVline(s) to| 0.5kV,*1KkV,*2kV | Mains power quality should
61000-4-5 line(s) line(s) to earth be that of a typical
+0.5 kV, 1 kV, +2kV commercial or hospital
line(s) to earth environment.
Voltage dips, Voltage dips : Voltage dips : Mains power quality should
short be that of a typical
interruptions 0% UT; 0.5 cycle 0% UT; 0.5 cycle commercial or hospital

environment. If the user of
the Data Recorder requires
continued operation during
power mains interruptions, it
is recommended that the
Data Recorder be powered
from an un-interruptible

Voltage
0% UT; 250/300 cycle

interruptions

Voltage interruptions 0%
UT; 250/300 cycle

power supply or a battery.

(50/60 Hz)
magnetic field

IEC61000-4-8

Power frequency

30A/m
50 Hz or 60 Hz

30A/m
50 Hz or 60 Hz

Power frequency magnetic
fields should be at levels
characteristic of a typical

location in a typical
commercial or hospital

environment.

NOTE: UT is the AC mains voltage prior to application of the testlevel.
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Guidance and manufacturer’s declaration - electromagneticimmunity

The Data Recorder is intended for use in the electromagnetic environment specified below.

The user of the Data Recorder should assure that it is used in such anenvironment.

Immunity test | IEC 60601 test Compliance level Electromagnetic
level environment -
guidance
Portable and mobile RF
communications equipment
should be used no closer to any
part of the Data Recorder,
including cables, than the
recommended separation
distance calculated from the
equation applicable to the
frequency of the transmitter.
Recommended separation
distance
Conducte 3V 3V Mains power quality should
d RF 150 kHz - 80 MHz | 150 kHz - 80 MHz be that of a typical
IEC commercial or hospital
61000-4- environment.
6 6 V in ISM bands 6 V in ISM bands
between 150 between 150
kHz kHz
and 80 MHz and 80 MHz
80% AM at 1 kHz 80% AM at 1 kHz
Radiated RF 3V/m 3V/m Mains power quality should
IEC 80 MHz-2.7GHz | 80MHz- 2.7 GHz be that of a typical
61000-4-3 commercial or hospital
80% AM at 1 kHz 80% AM at 1 kHz .
environment.
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10.5.2 Capsule

Guidance and manufacturer’s declaration - electronicemissions
The Capsules are intended for use in the electromagneticenvironment specified below.
The user of the Capsules should assure that it is used insuch an environment.
Emissions test Compliance Electromagnetic environment - guidance
Radiated Group 1 The Capsules uses RF energy only for its
emissions internal function. Therefore, its RF emissions
CISPR 11 are very low and are not likely to cause any
Conducted Class B interference in nearby electronic equipment.
emissions
CISPR 11
Harmonic N/A The Capsules are suitable for wuse in all
Emissions IEC establishments including domestic establishments
61000-3-2 and those directly connected to the public low-
Voltage N/A voltage power supply network that supplieg
fluctuations buildings used for domestic purposes.
and flicker
emissions
IEC 61000-3-3

Guidance and manufacturer’s declaration - electromagneticimmunity
The Capsules are intended for use in the electromagneticenvironment specified below.
The user of the Capsules should assure that it is used insuch an environment.

Immunity test IEC 60601 testlevel Compliance level| Electromagnetic
environment -
guidance

Electrostatic +8 kV +8 kV Floors should be wood,
discharge contact contact concrete or ceramic til.e. If

IEC 61000-4-2 discharge discharge floors are covered with

+2~15 KV air +2~15 KV air synthetic material, the
discharge discharge relative humidity should be
+8 kV +8 kV atleast 30%.
Horizontal Horizontal
Coupling Coupling
+8 kV Vertical +8 kV Vertical

Coupling Coupling
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Guidance and manufacturer’s declaration - electromagneticimmunity

The Capsules are intended for use in the electromagneticenvironment specified below.

The user of the Capsules should assure that it is used insuch an environment.

Electrical +2 kV for power N/A N/A
fast transient/burst supply Lines
IEC 61000-4-4 +1 kV for input/output
Lines
Surge IEC/EN +0.5 kV, 1 kV line(s) N/A N/A
61000-4-5 to line(s)
+0.5kV, 1 kV, +2 kV
line(s) to earth
Voltage dips, short Voltage dips : N/A N/A
interruptions
and voltage 0% UT; 0.5
cycle
variations on At 0°,45°,90°,
power supply 135°,180°, 225°, 270°
input Lines and 315°
IEC61000-4-11
0% UT; 1 cycle and
70% UT; 25/30
cycles Single phase:
at0°
Voltage
interruptions:
0% UT; 250/300
cycle
Power frequency (30 A/m 30A/m Power frequency magnetic
(50/60 Hz) magnetic |50 Hz or 60 Hz 50 Hz or 60 Hz fields should be at levels
field characteristic of a typical
[EC 61000-4-8 location in a typical commercial
or hospital environment.

NOTE: UT is the AC mains voltage prior to application of the testlevel.
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Guidance and manufacturer’s declaration - electromagneticimmunity

The Capsules are intended for use in the electromagnetic environment specified below.

The user of the Capsules should assure that it is used insuch an environment.

Immunity test IEC 60601 test Compliance level Electromagnetic
level environment -
guidance
Portable and mobile RF
communications equipment
should be used no closer to any
partofa Capsule, including
cables, than the recommended
separation distance calculated
from the equation applicable
to the frequency of the
transmitter.
Recommended separation
distance
Conducted RF 3V N/A N/A
IEC 61000-4-6 150 kHz - 80 MHz
6 V in ISM bands
between 150 kHz
and 80 MHz
80% AM at 1 kHz
Radiated RF 3V/m 3V/m Mains power quality should
IEC 80 MHz-2.7GHz | 80 MHz- 2.7 GHz be that of a typical
61000-4-3 commercial or hospital
80% AM at 1 kHz 80% AM at 1 kHz environment.
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10.5.3 Locator

Guidance and manufacturer’s declaration - electronic emissions

The Locator is intended for use in the electromagnetic environment specified below.

The user of the Locator should assure that it is used in such an environment.

fluctuations and
flicker emissions
IEC 61000-3-3

Emissions Compliance Electromagnetic environment - guidance
test
Radiated Group 1 The Locator uses RF energy only for its internal
emissions CISPR function. Therefore, its RF emissions are very
11 low and are not likely to cause any interference
Conducted Class A in nearby electronic equipment.
emissions CISPR
11
Harmonic N/A The harmonic current test and The voltage fluctuation
Emissions IEC and flick test are not necessary because the Locator isn’t
61000-3-2 intended to be connected to the PUBLIC MAINS
Voltage N/A NETWORK.

Guidance and manufacturer’s declaration - electromagneticimmunity

The Locator is intended for use in the electromagnetic environment specified below.

The user of the Locator should assure that it is used in such an environment.

] . Electromagnetic
Immunity test IEC 60601 testlevel Compliance level . .
environment - guidance
Electrostatic +8 kV +8 kV Floors should be
discharge contact discharge contact discharge wood, concrete or
IEC 61000-4-2 *2~15 kV air discharge *2~15 kV air discharge ceramic tile. If floors
+8 kV +8 kV are covered with
Horizontal Coupling Horizontal Coupling synthetic material, the
+8 kV Vertical Coupling +8 kV Vertical Coupling relative humidity
should be at least
30%.
Electrical fast +2 kV for power +2 kV for power supply Mains power quality
transient/burst supply Lines Lines should be that of a
IEC 61000-4-4 +1 kV for input/output typical commercial or
Lines hospital environment.

ANKON Technologies Co., Ltd.
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Guidance and manufacturer’s declaration - electromagneticimmunity

The Locator is intended for use in the electromagnetic environment specified below.

The user of the Locator should assure that it is used in such an environment.

Surge
IEC/EN
61000-4-5

+0.5 kV, £1 kV line(s) to
line(s)
+0.5kV, 1 kV, £2 kV

line(s) to earth

*0.5kV, £1 kV, x2 kV

line(s) to earth

Mains power quality
should be that of a
typical commercial or
hospital environment.

Voltage dips,
short
interruptions and
voltage variations
on power supply
inputLines

IEC 61000-4-11

Voltage dips :

0% UT; 0.5
cycle
At 0°,45°,90°,135°,
180°, 225°,270° and
315°

0% UT; 1 cycle
and
70% UT; 25/30

cycles Single phase: at 0°

Voltage interruptions

0% UT; 250/300

Voltage dips :

0% UT; 0.5
cycle
At 0°,45°,90°,135°,
180°, 225°,270° and
315°

0% UT; 1 cycle
and
70% UT; 25/30

cycles Single phase: at 0°

Voltage interruptions

0% UT; 250/300

Mains power quality
should be thatofa
typical commercial or
hospital environment.
If the user of the Data
Recorder requires
continued operation
during power mains
interruptions, it is
recommended that
the Locator be
powered from an un-
interruptible power
supply or a battery.

IEC 61000-4-8

cycle cycle
Power frequency 30A/m 30A/m Power frequency
(50/60 Hz) magnetic fields
magnetic 50 Hz or 60 Hz 50 Hz or 60 Hz Should be at levels
Field

characteristic of a
typical location in a
typical commercial or
hospital environment.

NOTE: UT is the AC mains voltage prior to application of the testlevel.
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ANKON Technologies Co., Ltd.

Guidance and manufacturer’s declaration - electromagneticimmunity
The Locator is intended for use in the electromagnetic environment specified below.
The of the Locator should assure that it is used in such an environment.
. IEC 60601 test . Electromagnetic
Immunity test Compliance level . .
level environment - guidance
Portable and mobile RF
communications equipment
should be used no closer to
any part of the Locator,
including cables, than the
recommended separation
distance calculated from the
equation applicable to the
frequency of the transmitter.
Recommended separation
distance
Conducted 3V 3V Mains power quality should
RF 150 kHz - 80 MHz| 150 kHz - 80 MHz be that of a typical
IEC 6V in ISM 6V in ISM commercial or hospital
in in :
4- environment.
61000-4-6 bands bands between
between 150 150 kHz
kHz and 80 MHz
and 80MHz | gno4 AM at 1 kHz
80% AM at 1
kHz
Radiated RF 3V/m 3V/m Mains power quality should
IEC 80 MHz - 2.7 GHz| 80 MHz - 2.7 GHz b“hat."{a ti’lpica_l 1
61000-4-3 commercial or hospita
80% AM at 1 kHz| 80% AM at 1 kHz environment.
AKQWO-YF-018 RevA/1
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CHAPTER 11: SYSTEM LABELING

Followings are labels of the system components:

Symbol Description
SN Serial Number
d Manufacturer
& Date of Manufacture
i Type BF Applied Part
® Do not re-use
STERILEEO Sterilized using ethylene oxide
IP X8 IP Code(10m,2h)
LOT Batch Code
H Use by

N
—
L ]

S

\-—/

Non-ionizing electromagnetic radiation

Do not use if package is damaged

Refer to instruction manual/booklet

Caution

Symbol for “ENVIRONMENT
PROTECTION - Waste electrical
products should not be disposed of with
household waste. Please

I > Q @
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Symbol

Description

recycle where facilities exist. Check with
your local Authority or
retailer for recycling advice.”

@ =nHoON _Data Recorder
Model:AKR-1
Inm:ms.ﬂmelpzzdl\ [1] E
Battery:==3.6-4,2V NCR 186508

FCC ID: 2A6BYAKR-1

SN:

83-2,83.3,034 Biolake,No.668,
ll: Hi-Tech Road, East Lake
Now Tachnal Drval

ogy lopment Zone,
Wuhan 430075 Hubei, China,

Nameplate of Data Recorder (AKR-1)

) 3= Locator
s OABX

Battery:==3.6-4.2V
NCR 186508

ELZ

:B3-2,83-3,03-4 Biclake,No.666,
Hi-Tech Road East Laks New
Technology Development Zone,
Wuhan 430075 Hubel,China.

Nameplate of Locator
(AKS-1)

€) @HOM Data Recorder
Modal: AKRI-1
L ¥, uvm@'mﬂk@ z
Battery: === 3.7-4.2V . uvsedz89
FCC ID: 2A6BYAKRI-1
SN:
dl:
B3-2, B3-3, D3-4 Biolake,No 688,
' Hi-Tech Road, East Lake

HNew Technology Developmant Zone,
Wuhan, 430875 Hubei,China.

Nameplate of Data Recorder (AKRI-1)

Keep dry

This Side Up

Stacking Limit (Not Exceed 3 Layers)

Temperature Limit -25C~70C
(transport and storage)
Humidity Limit 0%~90%

(transport and storage)

ANKON Technologies Co., Ltd.
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Symbol Description

1060hPa

Pressure Limit 700hPa~1060hPa

700hPa

ANKON Technologies Co., Ltd. AKQWO-YF-018 RevA/1





